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@Carlson. =~
“ QObjectives

» Project Setup and Settings to best utilize Field To Finish Projects for both the Field
and Office with Carlson Software

» Perform steps processing field collected data with SurvPC Field Collection Software

» Perform steps processing field data with Carlson Survey and best practices
gathering data from your field surveying software

> Field/Group Exercise on Creating and Sharing a Field To Finish file...

» Explore the options within Point Cloud Data from Drone (or Terrestrial) and utilize
what you've learned in F2F

» Explore and Learn the Feature Extraction Options within Carlson Software

I‘ Carlson.

BREAK NEW GROUND

Objectives

Yes, learning can be fun....
Let's make that a Goal of Today!
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W GROUND

Field-to-Finish

What is a Field-to-Finish program within

your origination?

A Field-to-Finish program has a user defined code table
that controls how field surveyed points with these
codes or descriptions will draw in CAD as connected
line work and symbols in pre-defined layers
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" Field-to-Finish

Setup your Office CAD Standards with Field to Finish

I‘ Carlson.

Field/Description Codes Definitions
(BLD, BC, FH, UP, ...)

Layers for:
* 2D Polylines Layer (zero elevation)
* 3D Polylines Layer (at their true elevation)
* Both 2D & 3D Polylines Drawn in Separate Layers
* Symbols and their Layers
* Point Labels and their Layers

@Carlson.  riald-to-Finish

Carlson Survey: Survey > Draw Field to Finish
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SurvPC: File - Code List...

@, Code List: AS1
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Category: }ALL v I [ Set I Mge Groupsl
Code Linework Line Type|Layer Name! Full Text Code &
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EOP Yes 3D EOP EOP

EP Yes 3D EP EP

v
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Field-to-Finish B

it Code v

Code: IPF

Category: [N CATEGORY | ©

Name: POINT1\spt135.bmp

v ot
[

Full Text: IPF
s
(2D Polyline

(3D Polyline

Allows for a customized setting for
each “Code Definition”




I‘ Carlson.

 Field-to-Finish

"Special Codes”
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Field-to-Finish

"Special Codes”

i, Special Codes

[Code Action

Space Code Separator

None String Designator

ST Begin Line Prompt At:

| [[Istore GIS Line Data to All Vertices End
|EL End Line
| []Add New Descriptions to FC List
|PC ArcPC [CJsave Only One GIS Feature to the Stored Pt
‘ [store Attribute(AT) to RWS File
\PT Arc PT [Juse Cade Notes Only, when Storing Paints
" [/]Autc-increment Colors for Linework
\Carlson [aut Layers for Linewark
[]Recall Last Point Note
@SEV& Last Point Note to Note List
[lAuto-Create Linework Laver: <CODE> <LAYER>

J

»
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Field-to-Finish

» Why Field-to-Finish

“...I've tried in the past, but just can’t get it to work! ”

»Who is using Field-to-Finish?
» Small Companies
» Medium Companies
» Large Companies
» Small and Large Government Agencies
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Where is your Field-to-Finish...

» No preset Code List // No Standards

» Symbols not set up properly

> Special codes not used properly (start/stop/2D/3D)
» Field crews using incorrect codes or inconsistent use
» “..We're Getting There...”

» Change... “...I've done it this way for years, why change now!”

orld 2010.
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v GROUND

Field-to-Finish
History

v’ Been around for more than 20+ years

v Assist surveyors with ‘connecting the dots’
(aka. Linework...)

v" Ability to place map symbols at specific locations
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~ Field-to-Finish
Why Field-to-Finish

v’ Speed up the process of connecting points with
linework and symbols — Map Making Bussiness

v Create a cleaner map that also helps with the quality
v* Assists with creating an accurate DTM

v' Assists with maintaining proper CAD standards
(color/line-type/layers)
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Field-to-Finish

What to expect

Expect these results from the beginning?
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Field-to-Finish
To get the Good...
...You have to go through the bad and the ugly
/. / e,
i g > #/ / /4; //Zfr/d =)
/"‘// ¢ /)/'/
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Carlson.
Field-to-Finish
Field Codes — Alpha

Recommended *
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Field-to-Finish

Field Codes - Numeric
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Field Codes — Symbols and Linework
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Field-to-Finish

Now we have codes...

How do we connect the points?

» Whatdo | do ???
» What order do | collect points ???

» How is my software going to connect the dots ???
= Field Software

oftware
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Collecting the:
Point(s)... Data... Linework...
Sequential — connect in the order the
points were collected

Nearest Found — connect based on
distance between points

1/11/2025
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Field-to-Finish

Field-to-Finish ~ “ doesn’t start in the office “
* Need codes (points) for field-to-finish
* Get Input from Field Crews... Empower the crews within the process and
be apart of the team!
* Ability to see the Field-2-Finish, in the field...

— Good
+ Eliminate missed shots before get back to the office
* Make sure code used is correct
— Bad
* Missed shots which require another trip to job
* Might get the shot, but forgot the code
- Ugly
* Multiple missed shots in the field
* Having bad day and can’t remember any codes
« Costs You 5555
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Field-to-Finish

Is that all Field-to-Finish does??

v’ Buildings are not flat
v’ Earth is not round
v’ Land is not level

24




(@ Carlson.
Field-to-Finish
Field-to-Finish for 3D

* Correct Field-to-Finish for Contours
0 Good : Smooth Contours / Accurate Map
O Bad: Crossing Breaklines = Wavy Contours

O Ugly: No Breaklines = Contours Everywhere
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Field-to-Finish
Simplif
How???
» Set a standard for codes within your company
» Cut down on time spent connecting the dots
» Place linework and symbols in correct location
» Cut down on missed points in the field

» Drawings being turned out are more uniform

» Eliminate time figuring out what does a code mean
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Field-to-Finish
Bottom Line...
Field-to-Finish:

“Improves your process of Map Making..."

Makes your Company More Profitable...
And produces a better high-quality product
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Field-to-Finish

* Start out slow
— Work on one or two codes a month

» Before you know it...

SISt
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| - \

t
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Lets take a look how this is done!

on )
CmssurvPC

First with Carlson SurvPC

then... with Carlson Survey sgrer
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Cloud Module

Getting Started with Carlson Point
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Launching

« Point Clouds Icon
« “PTCLOUD” command -
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Start a new project

& Pomt Cloud Advanced (Dec 26 2024}

it e
;
‘ i &0

Hew Ppen Clote S

Current Project

Enter name and linear unit. Defaults to drawing unit

@ New Poimt Cloud Project
CiCarson Projects FaniCioud

Foicer

Projettame

unarvne | ~|
o cann
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Project Page

« Upper toolbar
« Project tree
- Outlines all entities in
the project
> Most data is in
“Processed Data” folder

« Command History

33

11



GROUND
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Import a Point Cloud

Clouds must be imported to an
internal format “bxyz” before

use. I 40Sw®O¢

On the project page right-click
the Clouds folder and select
import. Then select the type of
file to import from the
available options

LAS/LAZ, E57 and Scan3D are
the most common

DEVESRY [ domy.dt.avc i/ S04 gt]

GeaTF L047140)
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GROUND

8 impont Dave Pt Chous x

Import a Point Cloud

e Import File information: WKT
string saved with the file if
available

e Set name for imported file

e Select Orthomosaic if available

o Used with certain actions

e Change projection (optional)

e Set Linear unit

e Resample or Remove duplicates
(optional)

o If point cloud has 500 million+
points “Remove duplicated nasanoie
points” will be on by default

Remare aupsated pants
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GROUND Qrnr—— x

Scene fos View

View the Point Cloud
<Cloud to view>->Right-Click->View

Create Scene Dialog

« Select Color Mode
« Set Rendering options
« Set Projection mode

36
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@ Carlson

Requires a scene
viewer window open

Scene Page

« Scene Entity tree
« Click on entities in tree for
specific controls and settings
- Hide/Show
> Color Mode
- Point Cloud Classifications

1/11/2025
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@ Carlson.

Requires a scene
viewer window open

Action Page |

« Selection e

« Point Cloud Editing and
Transformation

« Create entities =St
. Extract features
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@ Carlson

Merge Clouds

Point Cloud Clean

Clean
Bare Earth

« Project Tree->Right-click Kok
cloud->Clean e

« With a scene open with the
cloud:

Action Page-> Edit->Clean

39
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@ Carlson

Point Cloud Clean

« Remove Duplicated Points - Results
in the point cloud have
approximately even spacing of
Distance Threshold

« Remove Isolated Points - can remove
small clumps of points

« Remove Redundant Points -
decimates point cloud for surface
model creation (least common).
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@ Carlson.

Point Cloud Transformations

« Project Tree->Right-click <o s
cloud->Transform

« With a scene open with
the cloud:
Action Page-> Transform

41

@ Carlson

Point Cloud Transformations

« Scale - Quickly scale between common units such as US
Feet and Meters

« Elevate by Geoid or offset - Changes elevation of all
points

« Change Projection - Transform from one projection
system to another.

o Must know the current point cloud projection and target
projection

« Transformation Wizard offers advanced options for

scaling, offset and rotation by matrix.

42
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@ Carlson

Making a selection

« By perimeter polyline
« Byrectangle

« By sphere

« By color

1/11/2025
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@ Carlson.

Selection Actions

Hide

Delete

Create new entity

Classify - from Scene Page with a cloud selected in the
tree

« Use with supported extraction routines

o Bare Earth

o Building

o Contours

o Paint Lines

44
@ Carlson.
Field to Finish
Carlson Point Cloud Module
45
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Create Point Panel s

Available from Action Page-
>Create->Point

Allows for placement of -
Coordinate points with Field "
to Finish codes

1/11/2025
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F2F Code Setup

o Setif points will be added to
CRD point list (most common),
control point list or scan position
list

« Designate starting point number

o Set F2F code in description box

o Increment point number or use
custom settings

47
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EAK NEW GROUND

F2F Code Setup

« Code button allows setting a code from FLD file

A

&

SRBEREEE2EER
FEEESGE

48
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Manual Drafting

1/11/2025
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@ Carlson.

How to access
Action Page->Create->Point->Manual

50

@ Carlson.

Create Point Entity

« Use Point Entity
code

« Select “Add” Pick
Point Action

« Click on point in the
cloud to place CRD
point

51
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Create Polyline Entity

e Use a Polyline Entity

code

e Select “Add” Pick
Point Action

e Click on points along
feature. A polyline
will be drawn as
points are picked

e Special codes for
Begin and End are
added automatically.

52
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Point Editing
Select “Edit” " Edit Coordinate Point x
L] | )
pick pOint : ’i:r:r::llnalzi’um!
action and click | s
on Crd point D;lsmplmn:
« Edit parameters = - =
as needed 735503.414  2058567.865 20.338
« Screen Pick Saeenpick [ ]
a[lows for.re- ok Cancel Help
pick of point ¢ )
53
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Shortcuts o

« E key to end current polyline M it
« Cto close current polyline
« Right-Click
o Undo
o Edit
o Remove
o Move poneFiners >
« Shift Right-Click IS e
o Point Filters
o Snap Types

54
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@ Carlson

Tree and Pole extraction

1/11/2025
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@ Carlson.

How to access

Action Page->Create->Point->Features or by clicking
the Tree or Pole icons in the Scene View Window

OWr D I BPPEPz R A
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@ Carlson

Requirements

Point Cloud must have the Poles, Tree Trunks and
Canopies captured well for extraction to work

Tree trunk and canopy captured No tree trunk captured. Cannot extract
Extraction is possible

57
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All Feature options
o Hide points
o Add to classification
o Draw Solid
o Draw perimeter
Entity specific parameters
o Max Diameter properties need
to be tuned for best results
o Set a Description or Code per
entity

Extraction Options - Options Button

1/11/2025

& feature Recogrition Settngs

Hide Feature Points
44 Points Ta Classiiabion
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& Carlson.

Point Description
Descriptions include

Feature type
Height
Diameter
Lean

Tree type
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& Carlson.

Extract a pole or tree

Locate a pole or tree with
the trunk or base of pole
well defined and isolated
Click on the base of the pole
or trunk 6-24 in from the
base of the ground

If extraction fails, read
warning in command history
and adjust pick position or
parameters. Edit extracted
feature if necessary.

60
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Edit a Feature Point

Press “Edit Existing Feature” and
click on feature point

Can adjust

. Bottom/Top positions
« Diameters

o Lean

o Tree Type

« etc

61
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(& Carlson.

Feature Extraction
Carlson Point Cloud Module

62

& Carlson.

How To Access

« Action Page -> Extract

« Scene View Window -> Feature
Extraction

« Scene View Window ->
Classifications

DIACSPIRFEI 20 IQRK BAIOWC D24
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i@ Carlson.

Feature Extraction from the Action Page

. Bare Earth

. Contours

« Volumes

« Power Lines

« Building Outline
« More...

64
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Bare Earth

e By Expansion Method
o No parameters
o Can extract direct to TIN
o Works best for terrain with gradual slopes
o Cloud Linear Unit must be accurate
e By Grid
o Use if Expansion gives poor results
o Set Cell Size to minimum 5x the average point
spacing in the point cloud
o Increase Cell Size if the point cloud has a large
area and extraction runs slower than desired.
e By Profile
o For use with Ground LIDAR scans.
o Typically not needed over other methods

65
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Bare Earth By Expansion Example

66
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@ Carlson

Contours

« Create contours at regular
interval or at a specific
elevation

« Option to add Index contours

« Uses intermediate TIN which
can be simplified as needed

67

@ Carlson.

Contours

Contours appear in the project tree where they
can be drawn to CAD

@ Carlson

Extract Volumes

« Draw a Polyline using
the Create Polyline
Panel surrounding the
mound

o Set Extract units

« Optionally extract Tins
used for calculation

« Screen Pick the Polyline

& Extract Volume X

Cut: 07CY Cut Area: 23.3 SY
Fil: 54682 CY Fill Area: 1279.8 SY

Continue Cancel

69
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Extract Power Lines

Detection Modes

e 3-Point solves Catenary
curve from 3 screen picked
points

e 1-Point follows wire points
from one screen pick

— C it Acti
e 1-Point Draw all works same o]

as above but also looks for Exac lamioes

nearby parallel powerlines

in the search radius Polyline Layer Powerlines
Detection Mode [ Point

Draw All Search Radius

Find Power Line Undo

1/11/2025
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@ Carlson.

Extract Power Lines

3-point mode is best
when the wire is not
captured in the point
cloud well

1-point require the
wire be well captured
in the cloud to follow
accurately.
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@ Carlson.

Extract Buildings

e Extracts rough polylines of building
footprints, calculates approximate areas and
heights

e Recommended to use “Single By Wall” for
cloud made with ground lidar. Requires
clicking on a wall

e Recommended to use “All Buildings” for
other cases.

o Works with Selection

e Set Minimum Wall Height above height of =

fences for better results =

72
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BREAK NEW GROUND

Extract Buildings

Extracted outlines are
numbered with floor
count, height, and rea

A Building_Outline 1-1-10-2280

73
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Feature Extraction with Cloud and
Orthomosaic Image

« Parking Lines / Paint Stripes
« Curbs
« Smart Classifications

These routines utilize Machine Learning
techniques to detect features. Send us your
datasets to help us improve the detection!

nering You With the World 2010.
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BREAK NEW GROUND

Parking Lines / Paint Stripes _

e Paint lines - Extracts all paint
lines including road lines

e Parking Lines - Extracts parking
lines only as 3-point polylines

e Recommended to use Auto
Detection mode which
requires orthomosaic image.

e Use Selection Mode if
orthomosaic is not available.
Requires paint points be
selected well

75
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BREAK NEW GROUND

Parking Line Editor

Access from Line Editor button

on Parking Line extraction 0 =
panel oy B
« Create new w2 vion
« Fill in missing 2 "
« Edit existing P
« Review low confidence FRn s L

parking lines e

Active Line Narme:

1/11/2025
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P8 [iindzap v] Addiheplace. amovo

Parking Stall Counting

« Requires polylines from Parking Lines routine
« Counts stalls in between parking lines

« Manually edit spaces as Standard or Handicap
« Visualizes parking stalls with colored markers
Create a report with Carlson Report Formatter
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BREAK NEW GROUND

“Curbs” on the action page is
tegacy routine.

Curbs

Use Feature Extraction drop down -> Curbs.
Requires Orthomosaic Image

Detects the base of curb line and then offsets the
line to create top and back of curb lines

Classifications ~ Feature Extraction  Feature Com

aae Parking Lines I8

Paint Stripe

Curb Settings.
Curb
Trench

Help

78
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i@ Carlson.

EAK NEW GROUND

Curb Settings

Access from Feature e
Extraction drop down menu - ==
> Curb Settings... i

« Set Layer names
« Enable/disable back and
top of curb offset polylines |

« Sethorizontal and vertical | woceur oo e e
offset values

& Aomatc b
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i@ Carlson.

Smart Classifications

Access from Classifications
drop down menu -> Smart

Classifications from Image r‘ Carlson Digital Twin: Smart Classifications X
Set Classifications to extract [ Classification e E
from meny s
Sets color more to Concrete [
classification for Masonry (-]
visualization of results |Gravel (-]

Foliage -]

Grass -]

|8 Clear Existing Classifications

oK Cancel

80

i@ Carlson.

EAK NEW GROUND

Smart Classifications

ot Classificabons | Coior Mods
ID # Hide Select Name.
0

64
65
66
6 Gravel
68 Foliage
) Vehicles
7 Grass.
73 Bare Earth
75 Vehicle

27
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Field-to-Finish
Go Ahead...

CODE That Shot!!!

STenplae ke o
CARLSON

SuAvCE
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@ Carlson.

SESSION
EVALUATION

HTTPS://WWW.SURVEYMONKEY.COM/R/2025PSLSEVAL

83
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